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TAU Performance System®
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• Tuning and Analysis Utilities (15+ year project)

• Performance problem solving framework for HPC
– Integrated, scalable, flexible, portable

– Target all parallel programming / execution paradigms

• Integrated performance toolkit (open source) 
– Instrumentation, measurement, analysis, visualization

– Widely-ported performance profiling / tracing system

– Performance data management and data mining

• Broad application use (NSF, DOE, DOD, …)
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TAU Performance System Components
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Building Bridges to Other Tools
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TAU Instrumentation / Measurement
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Direct Performance Observation
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• Execution actions of interest exposed as events
– In general, actions reflect some execution state

• presence at a code location or change in data
• occurrence in parallelism context (thread of execution)

– Events encode actions for performance system to observe
• Observation is direct

– Direct instrumentation of program (system) code (probes)
– Instrumentation invokes performance measurement
– Event measurement: performance data, meta-data, 

context
• Performance experiment

– Actual events + performance measurements
• Contrast with (indirect) event-based sampling
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TAU Instrumentation Approach
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• Support for standard program events
– Routines, classes and templates
– Statement-level blocks
– Begin/End events (Interval events)

• Support for user-defined events
– Begin/End events specified by user
– Atomic events (e.g., size of memory allocated/freed)
– Flexible selection of event statistics

• Provides static events and dynamic events
• Enables “semantic” mapping
• Specification of event groups (aggregation, selection)
• Instrumentation optimization
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TAU Event Interface
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• Events have a type, a group association, and a name
• TAU events names are character strings

– Powerful way to encode event information
– Inefficient way to communicate each event occurrence

• TAU maps a new event name to an event ID
– Done when event is first encountered (get event handle)
– Event ID is used for subsequent event occurrences
– Assigning a uniform event ID a priori is problematic

• A new event is identified by a new event name in TAU
– Can create new event names at runtime
– Allows for dynamic events (TAU renames events)
– Allows for context-based, parameter-based, phase events
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TAU Instrumentation Mechanisms
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• Source code
– Manual (TAU API, TAU component API)
– Automatic (robust)

• C, C++, F77/90/95 (Program Database Toolkit (PDT))
• OpenMP (directive rewriting (Opari), POMP2 spec)
• Library header wrapping

• Object code
– Pre-instrumented libraries (e.g., MPI using PMPI)
– Statically- and dynamically-linked (with LD_PRELOAD)

• Executable code
– Binary and dynamic instrumentation (Dyninst)
– Virtual machine instrumentation (e.g., Java using JVMPI)

• TAU_COMPILER to automate instrumentation process
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Automatic Source-level Instrumentation
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Program Database Toolkit (PDT)
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MPI Wrapper Interposition Library
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• Uses standard MPI Profiling Interface
– Provides name shifted interface 

• MPI_Send = PMPI_Send

• Weak bindings 

• Create TAU instrumented MPI library
– Interpose between MPI and TAU

– Done during program link
• -lmpi replaced by –lTauMpi –lpmpi –lmpi

– No change to the source code!

– Just re-link application to generate performance data
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MPI Shared Library Instrumentation
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• Interpose the MPI wrapper library for applications 
that have already been compiled
– Avoid re-compilation or re-linking

• Requires shared library MPI
– Uses LD_PRELOAD for Linux
– On AIX use MPI_EUILIB / MPI_EUILIBPATH
– Does not work on XT3

• Approach will work with other shared libraries
• Use TAU tauex

– % mpirun -np 4 tauex a.out
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Selective Instrumentation File
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• Specify a list of events to exclude or include
• # is a wildcard in a routine name

BEGIN_EXCLUDE_LIST
Foo
Bar
D#EMM
END_EXCLUDE_LIST

BEGIN_INCLUDE_LIST
int main(int, char **)
F1
F3
END_INCLUDE_LIST
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Selective Instrumentation File
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• Optionally specify a list of files

• * and ? may be used as wildcard characters
BEGIN_FILE_EXCLUDE_LIST

f*.f90

Foo?.cpp 

END_FILE_EXCLUDE_LIST

BEGIN_FILE_INCLUDE_LIST

main.cpp

foo.f90

END_FILE_INCLUDE_LIST
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Selective Instrumentation File
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• User instrumentation commands
– Placed in INSTRUMENT section
– Routine entry/exit
– Arbitrary code insertion
– Outer-loop level instrumentation

BEGIN_INSTRUMENT_SECTION
loops file=“foo.f90” routine=“matrix#”
memory file=“foo.f90” routine=“#” 
io routine=“matrix#”
*static/dynamic+ phase routine=“MULTIPLY”
dynamic *phase/timer+ name=“foo” file=“foo.cpp” line=22 to line=35
file=“foo.f90” line = 123 code = "  print *, \" Inside foo\""
exit routine = “int foo()” code = "cout <<\"exiting foo\"<<endl;”
END_INSTRUMENT_SECTION
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TAU Measurement Approach
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• Portable and scalable parallel profiling solution
– Multiple profiling types and options
– Event selection and control (enabling/disabling, throttling)
– Online profile access and sampling
– Online performance profile overhead compensation

• Portable and scalable parallel tracing solution
– Trace translation to OTF, EPILOG, Paraver, and SLOG2
– Trace streams (OTF) and hierarchical trace merging

• Robust timing and hardware performance support
• Multiple counters (hardware, user-defined, system)
• Performance measurement of I/O and Linux kernel
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TAU Measurement Mechanisms
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• Parallel profiling
– Function-level, block-level, statement-level
– Supports user-defined events and mapping events
– Support for flat, callgraph/callpath, phase profiling
– Support for parameter and context profiling
– Support for tracking I/O and memory (library wrappers)
– Parallel profile stored (dumped, shapshot) during 

execution

• Tracing
– All profile-level events
– Inter-process communication events
– Inclusion of multiple counter data in traced events
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Types of Parallel Performance Profiling
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• Flat profiles
– Metric (e.g., time) spent in an event (callgraph nodes)
– Exclusive/inclusive, # of calls, child calls

• Callpath profiles (Calldepth profiles)
– Time spent along a calling path (edges in callgraph)
– “main=> f1 => f2 => MPI_Send” (event name)
– TAU_CALLPATH_DEPTH environment variable

• Phase profiles
– Flat profiles under a phase (nested phases are allowed)
– Default “main” phase
– Supports static or dynamic (per-iteration) phases
– Phase profiles may be generated from full callpath profiles in 

paraprof by choosing events as phases
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TAU Analysis
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Performance Analysis
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• Analysis of parallel profile and trace measurement

• Parallel profile analysis (ParaProf)
– Java-based analysis and visualization tool

– Support for large-scale parallel profiles

• Performance data management framework (PerfDMF)

• Parallel trace analysis
– Translation to VTF (V3.0), EPILOG, OTF formats

– Integration with Vampir / Vampir Server (TU Dresden)

– Profile generation from trace data

• Online parallel analysis and visualization

• Integration with CUBE browser (Scalasca, UTK / FZJ)
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ParaProf Profile Analysis Framework
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Performance Data Management
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• Provide an open, flexible framework to support 
common data management tasks
– Foster multi-experiment performance evaluation 

• Extensible toolkit to promote integration and reuse 
across available performance tools (PerfDMF)
– Originally designed to address critical TAU requirements
– Supported profile formats:

TAU, CUBE (Scalasca), HPC Toolkit (Rice), HPM Toolkit (IBM), gprof, 
mpiP, psrun (PerfSuite), Open|SpeedShop, …

– Supported DBMS:
PostgreSQL, MySQL, Oracle, DB2, Derby/Cloudscape

– Profile query and analysis API

• Reference implementation for PERI-DB project
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PerfDMF Architecture
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Metadata Collection
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• Integration of XML metadata for each parallel profile

• Three ways to incorporate metadata

– Measured hardware/system information (TAU, PERI-DB)

• CPU speed, memory in GB, MPI node IDs, …

– Application instrumentation (application-specific)

• TAU_METADATA() used to insert any name/value pair

• Application parameters, input data, domain decomposition

– PerfDMF data management tools can incorporate an XML file of 
additional metadata

• Compiler flags, submission scripts, input files, …

• Metadata can be imported from / exported to PERI-DB
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Performance Data Mining / Analytics
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• Conduct systematic and scalable analysis process
– Multi-experiment performance analysis
– Support automation, collaboration, and reuse

• Performance knowledge discovery framework
– Data mining analysis applied to parallel performance data

• comparative, clustering, correlation, dimension reduction, …

– Use the existing TAU infrastructure

• PerfExplorer v1 performance data mining framework
– Multiple experiments and parametric studies
– Integrate available statistics and data mining packages

• Weka, R, Matlab / Octave

– Apply data mining operations in interactive enviroment
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How to explain performance?

27

• Should not just redescribe the performance results
• Should explain performance phenomena

– What are the causes for performance observed?
– What are the factors and how do they interrelate?
– Performance analytics, forensics, and decision support

• Need to add knowledge to do more intelligent things
– Automated analysis needs good informed feedback

• iterative tuning, performance regression testing

– Performance model generation requires interpretation

• We need better methods and tools for
– Integrating meta-information
– Knowledge-based performance problem solving
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Role of Metadata and Knowledge Role
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PerfExplorer v2 – Requirements
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• Component-based analysis process
– Analysis operations implemented as modules
– Linked together in analysis process and workflow

• Scripting
– Provides process/workflow development and automation

• Metadata input, management, and access
• Inference engine

– Reasoning about causes of performance phenomena
– Analysis knowledge captured in expert rules

• Persistence of intermediate analysis results
• Provenance

– Provides historical record of analysis results
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PerfExplorer v2 Architecture
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Parallel Profile Analysis – pprof
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Parallel Profile Analysis – ParaProf

HPMToolkit

MpiP

TAU

Raw files

PerfDMF

managed

(database)
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Application

Experiment

Trial
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Metadata for Each Experiment

Multiple PerfDMF DBs
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ParaProf – Flat Profile

8K processorsnode, context, thread

Miranda

 hydrodynamics

 Fortran + MPI

 LLNL BG/L
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Comparing Effects of Multi-Core Processors

AORSA2D

 magnetized

plasma simulation

 Blue is single node

 Red is dual core

 Cray XT3 (4K cores)
35
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Comparing FLOPS (AORSA2D, Cray XT3)

AORSA2D

 Blue is dual core

 Red is single node

 Cray XT3 (4K cores)

 Data generated by 

Richard Barrett, ORNL
36
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ParaProf – Stacked View 
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ParaProf – Callpath Profile

Flash

 thermonuclear

flashes

 Fortran + MPI

 Argonne
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ParaProf  – Scalable Histogram
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8k processors 16k processors
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ParaProf – 3D View (Full Profile)
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128k processors

xbec
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ParaProf – 3D View (Full Profile)

16k processors

Miranda
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ParaProf – 3D Scatterplot
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• Each point is a “thread”
of execution

• A total of four metrics
shown in relation

• ParaProf’s
visualization
library
– JOGL

• Miranda, 32k cores
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Performance Mapping

• Example: Particles distributed on cube surface
Particle* P[MAX]; /* Array of particles */

int GenerateParticles() {

/* distribute particles over all faces of the cube */

for (int face=0, last=0; face < 6; face++){ 

/* particles on this face */

int particles_on_this_face = num(face);

for (int i=last; i < particles_on_this_face; i++) {

/* particle properties are a function of face */ 

P[i] = ... f(face);

...

}

last+= particles_on_this_face;

}

}
43
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Performance Mapping

44

• How much time (flops) spent processing face i particles?
• What is the distribution of performance among faces?

int ProcessParticle(Particle *p) {

/* perform some computation on p */

}

int main() {

GenerateParticles();

/* create a list of particles */

for (int i = 0; i < N; i++)

/* iterates over the list */

ProcessParticle(P[i]);

}

engine

work

packets
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No Mapping versus Mapping

• Typical performance tools 
report performance with 
respect to routines

• Does not provide support 
for mapping

• TAU’s performance 
mapping can observe 
performance with respect 
to scientist’s 
programming and 
problem abstractions 

TAU (no mapping) TAU (w/ mapping)

45
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NAS BT – Flat Profile

How is MPI_Wait()

distributed relative to

solver direction?

Application routine names

reflect phase semantics

46
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NAS BT – Phase Profile
Main phase shows nested phases and immediate events
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Phase Profiling of HW Counters

• GTC particle-in-cell simulation of fusion turbulence
• Phases assigned to

iterations
• Poor temporal locality for

one important data
• Automatically generated

by PE2 python script

increasing phase

execution time

decreasing 

flops rate

declining cache

performance

48
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Profile Snapshots in ParaProf
• Profile snapshots are parallel profiles recorded at runtime
• Shows performance profile dynamics (all types allowed)

Initialization

Checkpointing

Finalization

49
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Profile Snapshot Views

• Only show main loop • Percentage breakdown

50
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Snapshot Replay in ParaProf

All windows dynamically update

51
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PerfExplorer – Runtime Breakdown

MPI_Waitall

WRITE_SAVEFILE
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PerfExplorer – Relative Comparisons
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• Total execution time
• Timesteps per second
• Relative efficiency
• Relative efficiency per event
• Relative speedup
• Relative speedup per event
• Group fraction of total
• Runtime breakdown
• Correlate events with total runtime
• Relative efficiency per phase
• Relative speedup per phase
• Distribution visualizations
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PerfExplorer – Correlation Analysis

Data: FLASH on BGL(LLNL), 64 nodes  

Strong negative linear correlation between

CALC_CUT_BLOCK_CONTRIBUTIONS

and MPI_Barrier

54
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PerfExplorer – Correlation Analysis

55

• -0.995 indicates 
strong, negative 
relationship

• As CALC_CUT_
BLOCK_CONTRIBUTIO
NS() increases in 
execution time, 
MPI_Barrier() 
decreases
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PerfExplorer – Cluster Analysis 

56
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PerfExplorer – Cluster Analysis

• Four significant events automatically selected

• Clusters and correlations are visible

57
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PerfExplorer – Performance Regression
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Other Projects in TAU

59

• TAU Portal
– Support collaborative performance study

• Kernel-level system measurements (KTAU)
– Application to OS noise analysis and I/O system analysis

• TAU performance monitoring
– TAUoverSupermon and TAUoverMRNet

• PerfExplorer integration and expert-based analysis
– OpenUH compiler optimizations
– Computational quality of service in CCA

• Eclipse CDT and PTP integration
• Performance tools integration (NSF POINT project)
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Using TAU

60

• Install TAU
– % configure [options]; make clean install   

• Modify application makefile and choose TAU configuration
– Select TAU’s stub makefile
– Change name of compiler in makefile

• Set environment variables
– Directory where profiles/traces are to be stored/counter 

selection
– TAU options

• Execute application
– % mpirun –np <procs> a.out; 

• Analyze performance data
– paraprof, vampir, pprof, paraver …
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Application Build Environment
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• Minimize impact on user’s application build procedures
• Handle parsing, instrumentation, compilation, linking
• Dealing with Makefiles

– Minimal change to application Makefile
– Avoid changing compilation rules in application Makefile
– No explicit inclusion of rules for process stages

• Some applications do not use Makefiles
– Facilitate integration in whatever procedures used

• Two techniques:
– TAU shell scripts (tau_<compiler>.sh)

• Invokes all PDT parser, TAU instrumenter, and compiler

– TAU_COMPILER
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Configuring TAU
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• TAU can measure several metrics with profiling 
and tracing approaches

• Different tools can also be invoked to instrument 
programs for TAU measurement

• Each configuration of TAU produces a 
measurement library for an architecture

• Each measurement configuration of TAU also 
creates a corresponding stub makefile that can be 
used to compile programs

• Typically configure multiple measurement 
libraries
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TAU Measurement System Configuration

63

• configure [OPTIONS]
– {-c++=<CC>, -cc=<cc>} Specify C++ and C compilers
– -pdt=<dir> Specify location of PDT 
– -opari=<dir> Specify location of Opari OpenMP tool
– -papi=<dir> Specify location of PAPI 
– -vampirtrace=<dir> Specify location of VampirTrace
– -mpi[inc/lib]=<dir> Specify MPI library instrumentation 
– -dyninst=<dir> Specify location of DynInst Package
– -shmem[inc/lib]=<dir> Specify PSHMEM library instrumentation
– -python[inc/lib]=<dir> Specify Python instrumentation
– -tag=<name> Specify a unique configuration name
– -epilog=<dir> Specify location of EPILOG 
– -slog2 Build SLOG2/Jumpshot tracing package
– -otf=<dir> Specify location of OTF trace package
– -arch=<architecture> Specify architecture explicitly 

(bgl, xt3,x86_64,x86_64linux…) 
– {-pthread, -sproc} Use pthread or SGI sproc threads
– -openmp Use OpenMP threads
– -jdk=<dir> Specify Java instrumentation (JDK) 
– -fortran=[vendor] Specify Fortran compiler
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TAU Measurement System Configuration

64

• configure [OPTIONS]
– -TRACE Generate binary TAU traces
– -PROFILE (default) Generate profiles (summary)
– -PROFILECALLPATH Generate call path profiles
– -PROFILEPHASE Generate phase based profiles
– -PROFILEMEMORY Track heap memory for each routine
– -PROFILEHEADROOM Track memory headroom to grow
– Use hardware counters + time
– -COMPENSATE Compensate timer overhead
– -CPUTIME Use usertime+system time 
– -PAPIWALLCLOCK Use PAPI’s wallclock time
– -PAPIVIRTUAL Use PAPI’s process virtual time
– -SGITIMERS Use fast IRIX timers
– -LINUXTIMERS Use fast x86 Linux timers
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TAU Configuration – Examples
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• Configure using PDT and MPI for x86_64 Linux
./configure –pdt=/usr/pkgs/pkgs/pdtoolkit-3.15 

-mpiinc=/usr/pkgs/mpich/include -mpilib=/usr/pkgs/mpich/lib 
-mpilibrary=‘-lmpich -L/usr/gm/lib64 -lgm -lpthread -ldl’

• Use PAPI counters (one or more) with C/C++/F90 
automatic instrumentation for Cray CNL. Also instrument 
the MPI library. Use PGI compilers.
./configure -arch=craycnl -papi=/opt/xt-tools/papi/3.6.2 -mpi; make 

clean install

• Stub makefiles
/usr/pkgs/tau/x86_64/lib/Makefile.tau-mpi-pdt-pgi
/usr/pkgs/tau/x86_64/lib/Makefile.tau-mpi-papi-pdt-pgi
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Stub Makefiles Configuration Parameters
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• TAU scripts use stub makefiles to select performance measurements
• Variables:

– TAU_CXX Specify the C++ compiler used by TAU
– TAU_CC, TAU_F90 Specify the C, F90 compilers
– TAU_DEFS Defines used by TAU (add to CFLAGS)
– TAU_LDFLAGS Linker options (add to LDFLAGS)
– TAU_INCLUDE Header files include path (add to CFLAGS)
– TAU_LIBS Statically linked TAU library (add to LIBS)
– TAU_SHLIBS Dynamically linked TAU library
– TAU_MPI_LIBS TAU’s MPI wrapper library for C/C++
– TAU_MPI_FLIBS TAU’s MPI wrapper library for F90
– TAU_FORTRANLIBS Must be linked in with C++ linker for F90
– TAU_CXXLIBS Must be linked in with F90 linker 
– TAU_INCLUDE_MEMORY Use TAU’s malloc/free wrapper lib
– TAU_DISABLE TAU’s dummy F90 stub library
– TAU_COMPILER Instrument using tau_compiler.sh script
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TAU Measurement Configuration

67

• % cd /opt/tau-2.19.1/x86_64/lib; ls Makefile.*
– Makefile.tau-pdt
– Makefile.tau-mpi-pdt
– Makefile.tau-mpi-papi-pdt
– Makefile.tau-mpi-papi-pdt-trace
– Makefile.tau-pthread-pdt…

• For an MPI+F90 application, you may want to start with:
– Makefile.tau-mpi-pdt
– Supports MPI instrumentation & PDT for automatic source 

instrumentation
• % setenv TAU_MAKEFILE 

/opt/tau-2.19.1/x86_64/lib/Makefile.tau-mpi-pdt
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Using TAU: A brief Introduction

• To instrument source code using PDT
– Choose an appropriate TAU stub makefile in <arch>/lib:

% setenv TAU_MAKEFILE 
/opt/tau-2.19.1/x86_64/lib/Makefile.tau-mpi-pdt

% setenv TAU_OPTIONS ‘-optVerbose …’ (see tau_compiler.sh)

And use tau_f90.sh, tau_cxx.sh or tau_cc.sh as Fortran, C++ or C 
compilers:

% mpif90 foo.f90

changes to 
% tau_f90.sh foo.f90

• Execute application and analyze performance data:
% pprof   (for text based profile display)

% paraprof  (for GUI)

68
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TAU Measurement Configuration – Examples

% cd /usr/local/packages/tau-2.19.1/i386_linux/lib; ls Makefile.* on LiveDVD
Makefile.tau-pdt
Makefile.tau-mpi-pdt
Makefile.tau-papi-mpi-pdt
Makefile.tau-vampirtrace-papi-mpi-pdt
Makefile.tau-scalasca-papi-mpi-pdt
Makefile.tau-pthread-pdt
Makefile.tau-pthread-mpi-pdt
Makefile.tau-openmp-opari-pdt
Makefile.tau-openmp-opari-mpi-pdt
Makefile.tau-papi-openmp-opari-mpi-pdt
…
• For an MPI+F90 application, you may want to start with:
Makefile.tau-mpi-pdt

– Supports MPI instrumentation & PDT for automatic source instrumentation
– % setenv TAU_MAKEFILE 

/usr/local/packages/tau-2.19.1/i386_linux/lib/Makefile.tau-mpi-pdt

69



6th VI-HPS Tuning Workshop: The TAU Performance System

-PROFILE Option 

70

• Generates flat profiles

– One for each MPI process

– It is the default option.

• Uses wallclock time

– gettimeofday() sys call

• Calculates exclusive, inclusive time spent in 
each timer and number of calls
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Generating a Flat Profile with MPI

71

% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64

/lib/Makefile.tau-mpi-pdt

% set path=(/opt/tau-2.19.1/x86_64/bin $path)

% make F90=tau_f90.sh

(Or edit Makefile and change F90=tau_f90.sh)

% qsub run.job

% paraprof -–pack app.ppk

Move the app.ppk file to your desktop. 

% paraprof app.ppk
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Generating a Loop-level Profile

72

% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64

/lib/Makefile.tau-mpi-pdt

% setenv TAU_OPTIONS „-optTauSelectFile=select.tau –optVerbose‟

% cat select.tau

BEGIN_INSTRUMENT_SECTION

loops routine=“#”

END_INSTRUMENT_SECTION

% set path=(/opt/tau-2.19.1/x86_64/bin $path)

% make F90=tau_f90.sh

(Or edit Makefile and change F90=tau_f90.sh)

% qsub  run.job

% paraprof -–pack app.ppk

Move the app.ppk file to your desktop. 

% paraprof app.ppk
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Compiler-based Instrumentation
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% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64
/lib/Makefile.tau-mpi

% setenv TAU_OPTIONS „-optCompInst –optVerbose‟

% % set path=(/opt/tau-2.19.1/x86_64/bin $path)

% make F90=tau_f90.sh

(Or edit Makefile and change F90=tau_f90.sh)

% qsub  run.job

% paraprof -–pack app.ppk

Move the app.ppk file to your desktop. 

% paraprof app.ppk 
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-papi Option

74

• Instead of one metric, profile or trace with more than one metric
– Set environment variable TAU_METRICS to specify the metric

• % setenv TAU_METRICS TIME:PAPI_FP_INS:PAPI_L1_DCM...
• % setenv TAU_METRICS TIME:PAPI_NATIVE_<native_event>...

• When used with tracing (TAU_TRACE=1) option, the first counter 
must be TIME

• % setenv TAU_METRICS TIME:PAPI_FP_INS...
• Provides a globally synchronized real time clock for tracing

• -papi appears in the name of the stub Makefile
• papi_avail, papi_event_chooser, and papi_native_avail are useful 

tools
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Generate a PAPI profile
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% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64
/lib/Makefile.tau-papi-mpi-pdt

% setenv TAU_OPTIONS „-optTauSelectFile=select.tau –optVerbose‟

% cat select.tau

BEGIN_INSTRUMENT_SECTION

loops routine=“#”

END_INSTRUMENT_SECTION

% set path=(/opt/tau-2.19.1/x86_64/bin $path)

% make F90=tau_f90.sh

(Or edit Makefile and change F90=tau_f90.sh)

% setenv TAU_METRICS TIME:PAPI_FP_INS

% qsub  run.job

% paraprof -–pack app.ppk

Move the app.ppk file to your desktop. 

% paraprof app.ppk

Choose Options -> Show Derived Panel -> Click PAPI_FP_INS, Click / , Click 
TIME, Apply, choose the metric 
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-PROFILECALLPATH Option
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• Generates profiles that show the calling order (edges 
and nodes in callgraph)

– A=>B=>C shows the time spent in C when it was called by B 
and B was called by A

– Control the depth of callpath using TAU_CALLPATH_DEPTH 
environment variable

– -callpath in the name of the stub Makefile name or setting 
TAU_CALLPATH= 1 at runtime
(TAU v2.18.1+)
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-DEPTHLIMIT Option 

77

• Allows users to enable instrumentation at runtime based on 
the depth of a calling routine on a callstack
– Disables instrumentation in all routines a certain depth away 

from the root in a callgraph
• TAU_DEPTH_LIMIT environment variable specifies depth 

– % setenv TAU_DEPTH_LIMIT 1
– enables instrumentation in only “main”
– % setenv TAU_DEPTH_LIMIT 2
– enables instrumentation in main and routines that are directly 

called by main

• Stub makefile has  -depthlimit in its name:
– setenv TAU_MAKEFILE <taudir>/<arch>/lib/Makefile.tau-mpi-

depthlimit-pdt
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Generate a Callpath Profile
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% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64

/lib/Makefile.tau-mpi-pdt

% set path=(/opt/tau-2.19.1/x86_64/bin $path)

% make F90=tau_f90.sh

(Or edit Makefile and change F90=tau_f90.sh)

% setenv TAU_CALLPATH 1

% setenv TAU_CALLPATH_DEPTH 100

to generate the callpath profiles without any recompilation.

% qsub  run.job

% paraprof -–pack app.ppk

Move the app.ppk file to your desktop. 

% paraprof app.ppk

(Windows -> Thread -> Call Graph)
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Tracing in TAU

79

• Generates event-trace logs, rather than summary profiles
– setenv TAU_TRACE 1

• Traces show when and where an event occurred in terms of location 
and the process that executed it

• Traces from multiple processes are merged:
– % tau_treemerge.pl

• generates tau.trc and tau.edf as merged trace and event definition file

• TAU traces can be converted to Vampir’s OTF/VTF3, Jumpshot 
SLOG2, Paraver trace formats:
– % tau2otf tau.trc tau.edf app.otf 
– % tau2vtf tau.trc tau.edf app.vpt.gz
– % tau2slog2 tau.trc tau.edf -o app.slog2
– % tau_convert -paraver tau.trc tau.edf app.prv
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Generate a Trace File
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% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64

/lib/Makefile.tau-mpi-pdt

% set path=(/opt/tau-2.19.1/x86_64/bin $path)

% make F90=tau_f90.sh

(Or edit Makefile and change F90=tau_f90.sh)

% setenv TAU_TRACE 1

% qsub  run.job

% tau_treemerge.pl

(merges binary traces to create tau.trc and tau.edf files)

JUMPSHOT:

% tau2slog2 tau.trc tau.edf –o app.slog2 

% jumpshot app.slog2

OR

VAMPIR:

% tau2otf tau.trc tau.edf app.otf –n 4 –z

(4 streams, compressed output trace)

% vampir app.otf

(or vng client with vngd server)
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Instrumentation Specification
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% tau_instrumentor

Usage : tau_instrumentor <pdbfile> <sourcefile> [-o <outputfile>] [-noinline] 

[-g groupname] [-i headerfile] [-c|-c++|-fortran] [-f <instr_req_file> ] 

For selective instrumentation, use –f option

% tau_instrumentor foo.pdb foo.cpp –o foo.inst.cpp –f selective.dat

% cat selective.dat

# Selective instrumentation: Specify an exclude/include list of routines/files.

BEGIN_EXCLUDE_LIST

void quicksort(int *, int, int)

void sort_5elements(int *)

void interchange(int *, int *)

END_EXCLUDE_LIST

BEGIN_FILE_INCLUDE_LIST

Main.cpp

Foo?.c

*.C

END_FILE_INCLUDE_LIST

# Instruments routines in Main.cpp, Foo?.c and *.C files only

# Use BEGIN_[FILE]_INCLUDE_LIST with END_[FILE]_INCLUDE_LIST
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Outer Loop Level Instrumentation
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BEGIN_INSTRUMENT_SECTION

loops file="loop_test.cpp" routine="multiply"

# it also understands # as the wildcard in routine name

# and * and ? wildcards in file name. 

# You can also specify the full

# name of the routine as is found in profile files. 

#loops file="loop_test.cpp" routine="double multiply#"

END_INSTRUMENT_SECTION

% pprof 

NODE 0;CONTEXT 0;THREAD 0:

---------------------------------------------------------------------------------------

%Time    Exclusive    Inclusive       #Call      #Subrs  Inclusive Name

msec   total msec                          usec/call 

---------------------------------------------------------------------------------------

100.0         0.12       25,162           1           1   25162827 int main(int, char **)  

100.0        0.175       25,162           1           4   25162707 double multiply()  

90.5       22,778       22,778           1           0   22778959 Loop: double multiply()[ 

file = <loop_test.cpp> line,col = <23,3> to <30,3> ]  

9.3        2,345        2,345           1           0    2345823 Loop: double multiply()[ 

file = <loop_test.cpp> line,col = <38,3> to <46,7> ]  

0.1           33           33           1           0      33964 Loop: double 

multiply()[ file = <loop_test.cpp> line,col = <16,10> to <21,12> ]  
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Using TAU: A brief Introduction

• To instrument source code using PDT
– Choose an appropriate TAU stub makefile in <arch>/lib:

% setenv TAU_MAKEFILE 
/opt/tau-2.19.1/x86_64/lib/Makefile.tau-mpi-pdt

% setenv TAU_OPTIONS ‘-optVerbose …’ (see tau_compiler.sh)

And use tau_f90.sh, tau_cxx.sh or tau_cc.sh as Fortran, C++ or C 
compilers:

% mpif90 foo.f90

changes to 
% tau_f90.sh foo.f90

• Execute application and analyze performance data:
% pprof   (for text based profile display)

% paraprof  (for GUI)
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Usage Scenarios: Routine Level Profile

• Goal: What routines account for the most time? How much?

84
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Solution: Generating a flat profile with MPI

% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64

/lib/Makefile.tau-mpi-pdt

% set path=(/opt/tau-2.19.1/x86_64/bin $path)

Or

% module load tau

% make F90=tau_f90.sh

Or

% tau_f90.sh matmult.f90 –o matmult

(Or edit Makefile and change F90=tau_f90.sh)

% qsub run.job

% paraprof

To view. To view the data locally on the workstation, 

% paraprof -–pack app.ppk

Move the app.ppk file to your desktop. 

% paraprof app.ppk
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Usage Scenarios: Loop Level Instrumentation

• Goal: What loops account for the most time? How much?

• Flat profile with wallclock time with loop instrumentation:
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Solution: Generating a loop level profile
% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64

/lib/Makefile.tau-mpi-pdt

% setenv TAU_OPTIONS „-optTauSelectFile=select.tau –optVerbose‟

% cat select.tau

BEGIN_INSTRUMENT_SECTION

loops routine=“#”

END_INSTRUMENT_SECTION

% module load tau 

% make F90=tau_f90.sh

(Or edit Makefile and change F90=tau_f90.sh)

% qsub  run.job

% paraprof -–pack app.ppk

Move the app.ppk file to your desktop. 

% paraprof app.ppk
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Usage Scenarios: MFlops in Loops

• Goal: What execution rate do my application loops get in mflops? 

• Flat profile with PAPI_FP_INS/OPS and time (-papi) with loop 
instrumentation:
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Generate a PAPI profile with 2 or more counters
% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64

/lib/Makefile.tau-papi-mpi-pdt

% setenv TAU_OPTIONS „-optTauSelectFile=select.tau –optVerbose‟

% cat select.tau

BEGIN_INSTRUMENT_SECTION

loops routine=“#”

END_INSTRUMENT_SECTION

% make F90=tau_f90.sh

(Or edit Makefile and change F90=tau_f90.sh)

% setenv TAU_METRICS TIME:PAPI_FP_INS

% qsub  run.job

% paraprof -–pack app.ppk

Move the app.ppk file to your desktop. 

% paraprof app.ppk

Choose Options -> Show Derived Panel -> Arg 1 = PAPI_FP_INS, 

Arg 2 = GET_TIME_OF_DAY, Operation = Divide -> Apply, choose.
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Usage Scenarios: Compiler-based Instrumentation

• Goal: Easily generate routine level performance data using the compiler 
instead of PDT for parsing the source code
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Use Compiler-Based Instrumentation

% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64

/lib/Makefile.tau-mpi-pdt

% setenv TAU_OPTIONS „-optCompInst –optVerbose‟

% module load tau

% make F90=tau_f90.sh

(Or edit Makefile and change F90=tau_f90.sh)

% qsub  run.job

% paraprof -–pack app.ppk

Move the app.ppk file to your desktop. 

% paraprof app.ppk
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Generate a Callpath Profile
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Callpath Profile
• Generates program callgraph
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Generate a Callpath Profile

% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64

/lib/Makefile.tau-mpi-pdt

% set path=(/opt/tau-2.19.1/x86_64/bin $path)

% make F90=tau_f90.sh

(Or edit Makefile and change F90=tau_f90.sh)

% setenv TAU_CALLPATH 1

% setenv TAU_CALLPATH_DEPTH 100

% qsub run.job

% paraprof -–pack app.ppk

Move the app.ppk file to your desktop. 

% paraprof app.ppk

(Windows -> Thread -> Call Graph)
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Usage Scenario: Detect Memory Leaks
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Detect Memory Leaks

% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64 

/lib/Makefile.tau-mpi-pdt

% setenv TAU_OPTIONS „-optDetectMemoryLeaks -optVerbose‟

% module load tau

% make F90=tau_f90.sh

(Or edit Makefile and change F90=tau_f90.sh)

% setenv TAU_CALLPATH_DEPTH 100

% qsub  run.job

% paraprof -–pack app.ppk

Move the app.ppk file to your desktop. 

% paraprof app.ppk

(Windows -> Thread -> Context Event Window -> Select thread -> 

select... expand tree)

(Windows -> Thread -> User Event Bar Chart -> right click LEAK 

-> Show User Event Bar Chart)
NOTE: setenv TAU_TRACK_HEAP 1 and setenv TAU_TRACK_HEADROOM 1 may be used to track 

heap and headroom utilization at the entry and exit of each routine. 

TAU_CALLPATH_DEPTH=1 shows just the routine name, and 0 shows just one event for the 

entire program.
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Interval Events, Atomic Events in TAU

Interval event

e.g., routines

(start/stop)

Atomic events

(trigger with 

value)

% setenv TAU_CALLPATH_DEPTH 0

% setenv TAU_TRACK_HEAP 1
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Atomic Events, Context Events

% setenv TAU_CALLPATH_DEPTH 1

% setenv TAU_TRACK_HEAP 1

Atomic event

Context event

= atomic event

+ executing 

context
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Context Events (default)

% setenv TAU_CALLPATH_DEPTH 2

% setenv TAU_TRACK_HEAP 1

Context event

= atomic event

+ executing 

context
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Using tau_exec
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Environment Variables in TAU
Environment Variable Default Description

TAU_TRACE 0 Setting to 1 turns on tracing

TAU_CALLPATH 0 Setting to 1 turns on callpath profiling

TAU_TRACK_HEAP or 
TAU_TRACK_HEADROOM

0 Setting to 1 turns on tracking heap memory/headroom at routine entry & exit 
using context events (e.g., Heap at Entry: main=>foo=>bar)

TAU_CALLPATH_DEPTH 2 Specifies depth of callpath. Setting to 0 generates no callpath or routine 
information, setting to 1 generates flat profile and context events have just 
parent information (e.g., Heap Entry: foo)

TAU_SYNCHRONIZE_CLOCKS 1 Synchronize clocks across nodes to correct timestamps in traces

TAU_COMM_MATRIX 0 Setting to 1 generates communication matrix display using context events

TAU_THROTTLE 1 Setting to 0 turns off throttling. Enabled by default to remove instrumentation 
in lightweight routines that are called frequently

TAU_THROTTLE_NUMCALLS 100000 Specifies the number of calls before testing for throttling

TAU_THROTTLE_PERCALL 10 Specifies value in microseconds. Throttle a routine if it is called over 100000 
times and takes less than 10 usec of inclusive time per call

TAU_COMPENSATE 0 Setting to 1 enables runtime compensation of instrumentation overhead

TAU_PROFILE_FORMAT Profile Setting to “merged” generates a single file. “snapshot” generates xml format

TAU_METRICS TIME Setting to a comma separted list generates other metrics. (e.g., 
TIME:linuxtimers:PAPI_FP_OPS:PAPI_NATIVE_<event>)
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Compile-Time Environment Variables 

• Optional parameters for TAU_OPTIONS: [tau_compiler.sh –help]

-optVerbose Turn on verbose debugging messages

-optCompInst Use compiler based instrumentation

-optDetectMemoryLeaks Turn on debugging memory allocations/de-allocations to track leaks

-optKeepFiles Does not remove intermediate .pdb and .inst.* files

-optPreProcess Preprocess Fortran sources before instrumentation

-optTauSelectFile="" Specify selective instrumentation file for tau_instrumentor

-optLinking="" Options passed to the linker. Typically 
$(TAU_MPI_FLIBS) $(TAU_LIBS) $(TAU_CXXLIBS)

-optCompile="" Options passed to the compiler. Typically 
$(TAU_MPI_INCLUDE) $(TAU_INCLUDE) $(TAU_DEFS)

-optTauSelectFile="" Specify selective instrumentation file for tau_instrumentor

-optNoCompInst Do not revert to compiler-based instrumentation if source instrumentation fails

-optPdtF95Opts="" Add options for Fortran parser in PDT (f95parse/gfparse)

-optPdtF95Reset="" Reset options for Fortran parser in PDT (f95parse/gfparse)

-optPdtCOpts="" Options for C parser in PDT (cparse). Typically 
$(TAU_MPI_INCLUDE) $(TAU_INCLUDE) $(TAU_DEFS)

-optPdtCxxOpts="" Options for C++ parser in PDT (cxxparse). Typically
$(TAU_MPI_INCLUDE) $(TAU_INCLUDE) $(TAU_DEFS)

...
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Measuring Performance of PGI Accelerator Code
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Usage Scenarios: Mixed Python+F90+C+pyMPI

• Goal: Generate multi-level instrumentation for 
Python+MPI+C+F90+C++ ...
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Generate a Multi-Language Profile w/ Python
% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64

/lib/Makefile.tau-python-mpi-pdt

% set path=(/opt/tau-2.19.1/x86_64/bin $path)

% setenv TAU_OPTIONS „-optShared -optVerbose…‟

(Python needs shared object based TAU library)

% make F90=tau_f90.sh CXX=tau_cxx.sh CC=tau_cc.sh  (build pyMPI w/TAU)

% cat wrapper.py

import tau

def OurMain():

import App

tau.run(„OurMain()‟)

Uninstrumented:

% poe <dir>/pyMPI-2.4b4/bin/pyMPI ./App.py –procs 4

Instrumented:

% setenv PYTHONPATH <taudir>/x86_64/lib/bindings-python-mpi-pdt-pgi

(same options string as TAU_MAKEFILE)

setenv LD_LIBRARY_PATH <taudir>/x86_64/lib/bindings-icpc-python-mpi-pdt-

pgi\:$LD_LIBRARY_PATH

% poe <dir>/pyMPI-2.5b0-TAU/bin/pyMPI ./wrapper.py –procs 4

(Instrumented pyMPI with wrapper.py) 105
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Usage Scenarios: Evaluate Scalability

• Goal: How does my application scale? What bottlenecks at 
what cpu counts?

• Load profiles in PerfDMF database and examine with 
PerfExplorer
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Usage Scenarios: Evaluate Scalability
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Performance Regression Testing
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Evaluate Scalability using PerfExplorer Charts

% setenv TAU_MAKEFILE /opt/tau-2.19.1/x86_64

/lib/Makefile.tau-mpi-pdt

% set path=(/opt/tau-2.19.1/x86_64/bin $path)

% make F90=tau_f90.sh

(Or edit Makefile and change F90=tau_f90.sh)

% qsub  run1p.job

% paraprof -–pack 1p.ppk

% qsub  run2p.job …

% paraprof -–pack 2p.ppk … and so on.

On your client:

% perfdmf_configure

(Choose derby, blank user/passwd, yes to save passwd, defaults)

% perfexplorer_configure

(Yes to load schema, defaults)

% paraprof 

(load each trial: DB -> Add Trial -> Type (Paraprof Packed 

Profile) -> OK, OR use perfdmf_loadtrial on the commandline)

% perfexplorer 

(Charts -> Speedup) 109
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Communication Matrix Display

• Goal: What is the volume of inter-process communication? Along which calling 
path?
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Evaluate Scalability using PerfExplorer Charts

% setenv TAU_MAKEFILE 

$TAU/Makefile.tau-mpi-pdt

% set path=(/usr/local/packages/tau-2.19.1/x86_64/bin $path)

% make F90=tau_f90.sh

(Or edit Makefile and change F90=tau_f90.sh)

% setenv TAU_COMM_MATRIX 1

% qsub run.job (setting the environment variables)

% paraprof 

(Windows -> Communication Matrix)

(Windows -> 3D Communication Matrix)
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TAU Integration with IDEs

• High performance software development environments
– Tools may be complicated to use

– Interfaces and mechanisms differ between platforms / OS

• Integrated development environments
– Consistent development environment

– Numerous enhancements to development process

– Standard in industrial software development

• Integrated performance analysis
– Tools limited to single platform or programming language

– Rarely compatible with 3rd  party analysis tools

– Little or no support for parallel projects
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TAU and Eclipse

• Provide an interface for configuring TAU’s automatic instrumentation within 
Eclipse’s build system

• Manage runtime configuration settings and environment variables for execution of 
TAU instrumented programs

C/C++/Fortran

Project in Eclipse

Add or modify

an Eclipse build

configuration w/ TAU

Temporary copy

of instrumented code

Compilation/linking

with TAU libraries

TAU instrumented

libraries

Program

execution

Performance

data

Program

output
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TAU and Eclipse

PerfDMF
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Choosing PAPI Counters with TAU  in Eclipse

% /usr/local/packages/eclipse/eclipse
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Jumpshot

• http://www-unix.mcs.anl.gov/perfvis/software/viewers/index.htm

• Developed at Argonne National Laboratory as part of the MPICH project
– Also works with other MPI implementations

– Installed on IBM BG/P

– Jumpshot is bundled with the TAU package 

• Java-based tracefile visualization tool for postmortem performance analysis 
of MPI programs

• Latest version is Jumpshot-4 for SLOG-2 format
– Scalable level of detail support

– Timeline and histogram views

– Scrolling and zooming

– Search/scan facility
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Jumpshot
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For more information
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• TAU Website:
http://tau.uoregon.edu 

– Software

– Release notes

– Documentation


